
Quick Start Program
Installation Guide



Copyright © 2010 GroupLink Corporation. All Rights Reserved. ContactWise is a registered trademark of 
GroupLink Corporation. All other trademarks are the property of their respective owners.

Released May 2010 for ContactWise (version9.0) by GroupLink Corporation.

This material may not, in whole or in part, be copied, photocopied, reproduced, translated, or reduced to 
any electronic medium or machine‐readable form without prior consent in writing from GroupLink Corpora‐
tion 563 W 500 S Suite 400, Bountiful, UT 84010. 

ALL EXAMPLES WITH NAMES, COMPANY NAMES, OR COMPANIES THAT APPEAR IN THIS MANUAL ARE 
FICTION¬AL AND DO NOT REFER TO OR PORTRAY IN NAME OR SUBSTANCE ANY ACTUAL NAMES, COMPA‐
NIES, ENTITIES, OR INSTITUTIONS. ANY RESEMBLANCE TO ANY REAL PERSON, COMPANY, ENTITY, OR INSTI‐
TUTION IS PURELY COINCIDENTAL. 

Every effort has been made to ensure the accuracy of this material. However, GroupLink Corporation makes 
no warranties with respect to this documentation and disclaims any implied warranties of merchantability 
and fit¬ness for a particular purpose. GroupLink Corporation shall not be liable for any errors or for inciden‐
tal or con¬sequential damages in connection with the furnishing, performance, or use of this material or the 
examples herein. The information in this material is subject to change without notice. 

Produced by
GroupLink Corporation
563 West 500 South, Ste. 400
Bountiful, Utah
(801)335‐0700

www.grouplink.net

www.grouplink.net


Table of Contents
SYSTEM REQUIREMENTS.......................................................................................................................................................
   Client Machine(s) System Requirements............................................................................................................................
   User Requirements.............................................................................................................................................................
   Server Machine System Requirements...............................................................................................................................
   Operating System...............................................................................................................................................................
   Authentication Requirements............................................................................................................................................

INSTALLATION............. ..........................................................................................................................................................
   Installation Wizard..............................................................................................................................................................

LICENSING CONTACTWISE....... .............................................................................................................................................
   Purchased ContactWise License.........................................................................................................................................
   Evaluating ContactWise......................................................................................................................................................

OPEN CONTACTWISE & SFA DATABASE.................................................................................................................................
   Open ContactWise..............................................................................................................................................................
   Open the Company Database.............................................................................................................................................

ENABLE SECURITY FEATURES.................................................................................................................................................

GROUP RIGHTS IN CONTACTWISE.........................................................................................................................................

4
4
4
4
4
4

5
5

8
8
8

10
10
10

12

14



System Requirements
Client Machine(s) System Requirements

     •   Pentium III 800‐MHz or higher processor
     •   Windows 2000 or higher Operating System
     •   Minimum of 128 megabytes (MB) of RAM
     •   GroupWise v6.x or higher*
     •   Outlook 2007 or higher (32 bit version)*

User Requirements

     •   Email address capable of receiving SMTP email (from SMTP server listed in Server Requirement Section)

Server Machine System Requirements

     •   Minimum of 1 GB free hard drive space (expandable as needed)
     •   P4 class server or higher
     •   Minimum of 1 GB of RAM
     •   Minimum of 100 MB of free hard drive space (expandable as needed)
     •   SMTP server capable of relaying to desired domains

Operating System
   Windows

        •   Windows 2000 Server Operating System or higher

One of the Following

   MS SQL Server

        • Windows 2000 Server Operating System or higher
        •   MSSQL Server 2000, 2005, and 2008

   Oracle

        • Windows 2000 Server or higher
        • Oracle 9i

Authentication Requirements

     •   GroupWise 6.5 or higher, Outlook 2003, 2007, and 2010 for persistent identity management
     •   X.500 Compliant Directory with LDAP support (for optional ContactWise Security, anonymous binding 
          through port 389)

*Not required for core ContactWise functionality.
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Installation
Follow these steps to install ContactWise for your organization:

     •   Be sure GroupWise (or Outlook) is closed during the installation of ContactWise
     •   Use the cw.exe or cw.msi file to install ContactWise on your computer. If you don’t already have this file, 
          it can be downloaded using the following link:

          downloads.grouplink.net

          OPTIONAL:  If you wish to use MSDE as your database provider, you will also need to install MSDE. This 
          can be installed with the file named add_msde_sp3.exe. Use the following link to download this file:

          ftp://ftp.xmission.com/pub/users/g/grplink/cw611/add_msde_sp3.exe

          Follow the appropriate instructions below, depending on whether or not there is a previous version of 
          ContactWise installed on your computer:

          ‐   New ContactWise users (no version of ContactWise currently installed on computer) can simply install 
  ContactWise using the cw.exe or cw.msi file. Simply double click on the file and follow the instructions 
  on the screen.
          ‐   If you have a previous version of ContactWise on the computer (6.0 and up), you will need to uninstall 
  it before installing the current version.  It is important that you use Add/Remove programs to remove 
  the previous version. After uninstalling, continue as described above. If you have ContactWise 5.x on 
  the computer, it will be necessary to leave it installed for the database conversion process.

Installation Wizard
To open the ContactWise Installation Wizard, drag the cw.exe or cw.msi file you were sent to your desktop. 
Double‐click the file to open the Installation Wizard and follow the steps.

     •   In the first installation screen, click the Next button to open the License Agreement screen (Figure 1).

Figure 1

downloads.grouplink.net
ftp://ftp.xmission.com/pub/users/g/grplink/cw611/add_msde_sp3.exe
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     •   Select the I accept the license agreement radio button and click the Next button.
     •   In the next screen (Figure 2) select the user you wish to install ContactWise for and click Next.

Figure 2

     •   Next, select the destination folder where you wish ContactWise installed. You may choose to leave the 
          default as the destination.
     •   Once you have chosen the destination folder, click the Next button to open the Installation Type screen 
          (Figure 3).

Figure 3

     •   In the Installation Type screen, you will need to select which installation type you would like to use.

          ‐   A Typical installation is the most common option for users and only installs the ContactWise program.
          ‐   A Complete installation is generally used for the Administrator and installs the ContactWise client, the 
  Database Administrator, and the Import Utility.
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     •   After you have selected your Installation Type, click the Next button to open the final screen of the In‐
          stallation Wizard.
     •   Click the Next button to run the installation.

Once the installation is complete, you can open GroupWise or Outlook and click on the ContactWise icon to 
open the program.



Licensing ContactWise
How ContactWise is licensed depends on your situation:

   Purchased ContactWise License

        •   If you have purchased ContactWise, you should have received an email from GroupLink containing a 
 link to your license file. The name of the file is usually the name of your company with the extension 
 “exe”.
 Example: For a company with the name of ABC Company, the file name would be “ABCCompany.exe”.
        •   To install the license, simply double‐click on the license file. This will bring up a dialog box.
        •   Next, click the Setup button which will open the GroupLink License Installation Utility as show in Fig-
 ure 4.

Figure 4

        •   Click the Install License button. Your license will be installed and the following message (Figure 5) will 
 be displayed indicating the process is complete.

Figure 5

        •   You can now close the message by clicking the OK button and close the License Installation Utility.

   Evaluating ContactWise

        •   Open ContactWise using one of the following methods:

  ‐   Method 1 Open GroupWise and click the ContactWise icon  in the GroupWise or Outlook toolbar 
      and select the Open ContactWise menu item.
  ‐   Method 2 Open from the Windows Start menu by clicking Start | All Programs | GroupLink | Con-
      tactWise | ContactWise

        •   If you see the pop‐up in Figure 6, your licensse key has not been installed.
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Figure 6

        •  Click the Cancel button, install the license file, and restart ContactWise.
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Open ContactWise & Database
Open ContactWise
Either of the following methods may be used to open ContactWise:

     •   Open ContactWise through GroupWise or Outlook

          ‐   Open GroupWise or Outlook
          ‐   Click the ContactWise icon  in the GroupWise/Outlook toolbar
          ‐   Select the Open ContactWise menu item

     •   Open ContactWise through the Windows Start menu

          ‐   Click the Start button in the bottom, left‐hand corner of your screen
          ‐   Select All Programs | GroupLink | ContactWise | ContactWise

Open the Company Database
If you have never connected to your database, use the following steps:

     •   From the File menu, select Open Database to open the Open Database pop‐up (Figure 7)
     •   In the Open Database pop‐up, enter the Server, User Name, Password, and Database Name information

Figure 7

When you have filled in the appropriate information, click the OK button and your database will be successfully 
created.

If you have already created the company database and it does not open by default when ContactWise is 
opened, use the following steps (Figure 8) to open it.

     •   From the File menu, select Reopen Database
     •   Select the correct database from the extended database list to open
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Figure 8



Enable Security Features
Follow these steps to enable the ContactWise security features:

     •   Novell Directory Services (NDS) or Active Directory Services (ADS) must be running on the network.
     •   One of the NDS or ADS servers in the tree must have LDAP enabled.
     •   The database will need to be configured with the LDAP Server Type, name or IP address of the LDAP 
          server, and the port number where LDAP requests will be answered. The default port number is 389 if us‐
          ing clear text passwords. The default port number is 636 if using SSL.

          ‐   Open the ContactWise Database Administrator. This can be done from the Windows Start menu.

  Start | All Programs | GroupLink | ContactWise | Database Administrator

          ‐   To run the Database Administrator file manually from the .exe executable file called “DB Admin.exe” 
  located in the C:\Program Files\GroupLink\ContactWise folder.
          ‐   Make sure you are connected to the correct database by looking at the database information at the 
  top of the screen. If you are not connected to the correct database, connect by selecting the Database 
  menu, Reopen Database, and the correct database from the extended menu.
          ‐   Once the correct database is open, select the Options tab.
          ‐   Select the Security section on the left side of the screen (Figure 9).

FIgure 9
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     •   If SSL is being used, the security certificate will need to be registered on each client machine. Follow 
          these two steps:

          ‐   Obtain the certificate
          ‐   Install the certificate on the client machines (instructions based on Windows XP Operating System)    

   o   Double‐click on the Certificate file. This will open the Certificate dialog.
   o   On the General tab, click the Install Certificate button to open the Certificate Import Wizard.
   o   Click Next on the first page of the Wizard.
   o   In the second screen, choose the radio button labeled “Place all certificates in the following store” 
        and click the Browse button. This will open the Select Certificate Store dialog.
   o   In the Select Certificate Store dialog, check the box labeled “Show physical stores”.
   o   Expand the folder labeled “Trusted Root Certification Authorities”, select the Local Computer folder 
        and click the OK button.
   o   Click the Next button to go to the last screen and click the Finish button.

     •   If ContactWise Security was not turned on when the database was initially created, it needs to be turned 
          on from within the ContactWise Database Administrator. It is recommended to NOT turn on security 
          when first  creating a database, especially if you are not already familiar with the ContactWise security 
          model. It is best to become familiar with ContactWise and the Security model before turning on security.

          ‐   Launch the ContactWise Database Administrator and open the database from which security is to be 
  enabled.
          ‐   From the Tools menu, select the Add Security to Existing Database menu item.
          ‐   Follow the instructions in the Add Security Wizard.

     •   In order for a user to log into ContactWise, and LDAP username and non‐blank password will be required.
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Group Rights in ContactWise
To grant a group in NDS or ADS the right to view and modify a group of records in ContactWise, use the follow‐
ing steps:

     •   Enable security as outlined in the previous chapter.
     •   Open the ContactWise Database Administrator. This can be opened from the Windows Start menu.

          Start | All Programs | GroupLink | ContactWise | Database Administrator

     •   Select an NDS group in the Directory section and click the Add button as shown in Figure 10.

Figure 10

     •   Select Contact Visibility/Access and click the Next button (Figure 11).
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Figure 11

     •   In the next dialog box (Figure 12), first select the Group radion button and click the Select Contact(s)/
          Group button.

Figure 12

          This will open the Select a Group dialog (Figure 13) from which the appropriate ContactWise group can 
          be selected. Select the group and click the OK button.
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Figure 13

          Once this is complete, click the Next button.

Figure 14

     •   In the next dialog (Figure 15) check the appropriate rights and click the Finish button.

          Note that in this example, some default rights had already been set. You can see this by referring to 
          Figure 9. Since the read right was set by default, it is already set in this dialog with a gray checkmark, 
          indicating that it can’t be unchecked. Default Rights will overwrite any rights set in the Assigned Rights 
          section.
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Figure 15

For more information about using the security features, see ContactWise Help within the program.
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